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E-MAIL FORMSnteraction Management

SUMMARY

The 6 Ena i | f or ms & nuakemip possible for visitors of a GX WebManager website to
compose an e-mail and send it. This functionality is useful for  reporting error s, requesting
information, and so f orth. Be c a u s eE-maihferm & 8 mo d ar iktegrated part of the CMS,
it is guaranteed that the design of the forms will be correct

A standard e-mail form consists of two steps: the first step is for the visito r to enter their
e-mail and message deta ils and the second step is the displaying of a 6 Mank youd page. There
are several different ways that you can validate the vi si tnput.d s

PREREQUISITES

Content Management
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1 INTRODUCTION

An e-mail form is a simple version of a form. Just like more advanced forms, an e-mail form is an
instance of a form model. Before you can place an e-mail form on a page, you have to create an
e-mail form model.

A standard e-mail form model consists of two steps: In step 1, the visitor enters their personal

details and/or a message andin step2adt hank vy cudiSplayed tg the website visitor as an
acknowledgement that the e-mail was successfully sent to the recipient.

Example of an e-mail form:

A GX creative online development - Microsoft Internet Explorer

Ele Edt Miew Favorites Tools Help BX

esack - O @ @ (/;j pSEarch *Fa\mritss & @'% B - D g E*ﬁ

Address |a hittpef e g, nlfwebmanager fshow fid=66305/langid=42{Contact. html

CREATIVE ONLINE DEVELOPMENT

v|Gn

i links >

8|

: A
Home > The Company » Gontact =tiederlands- [l
The Company Contact
About GH We welcorme questions, comments and Contact data
suggestions. This web site is a practical Company *
Facts & Figures example of our approach! rou can sither [ |
use the contact form ar simply call us on aur
Managernent Tearn rmain telephone number. Chantal or Marieke Address Nr.

will 2nswer your call and assist you further, [

Hews & Events
G¥ creative online developrient BV, Zip code  City
Wijchenseweg 111 [ |

6538 SYW Mijmegen
Directions to our main office Hatherlands Phone number

in Mijmegen | |

» Contact

Directions to our Amsterdam T +31 (2)24 3383 261 E-mail
offices F +31 (0)24 3888 621 mail
E info@gx. nl [ ]
I www.gseonl

Your message

Directions to aur main office in Mijmegen

Directions to our office in Amsterdam

Send

Nederlands | Sitemap | Mews % Events | Partnerwsb | Contact | Print | Search ||

| | | | | | Intetnet '
a ® B

After the user enters their personal details and clicks [ Send] button, a page with a message like
6Thank you f or y o ureplyragsaanias posi. b is\desplayed! |
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E-MAIL FORMSinteraction Management

The e-mail and the e-mail form are separated from each other so that you have the
option of splitting a form over more than one page (for example, step 1 will be placed on
page A and step 2 on page B).

The different steps of an e-mail form are kept together regardless of the pages on which
they are placed; therefore e ach step of a form can only be used once. If a step of a n e-
mail form is shown on a page, it can no longer be selected in another form element.

If you want to place an (e-mail) on multiple pages on a website, you need to create
multiple (e-mail) form instances of the associated (e-mail) form model. These form
instances can then be used in different (e-mail) form elements.

[ | | | |
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2 DEFINING THE FORM MODEL

2.1 Creating a form model

= Select Maintain > Forms > E-mail formm odels from the menu.

= Create a new e-mail form model by clicking the [New form model] button and
selecting the new e-mail form mo d e | next to 0Select 0:

22 MyWeb, - E-mail form madels - Microsoft Internet Explorer

Maintain - E-mail form models

Form models in category: [ = All categories > v‘

Form model
ISeIect: | New e-mail form model v| ‘ New form model I| Copy form model |

Marne: |New e-rmail form model Category: | < no category = vl

Used in: Myweb - New e-rmail form model

Steps
Steps: Selected step
Step name ititle): ‘E-mai\ farm Display: ‘ Wt Form v
Thank you.
Subtitle: ‘ CEE class: ‘
Add part:

Text input field H List H Text ” Upload file

Text input field: Sender name [~ |+ X
Text input field: Sender address [~ X
Preview Edit

T T T
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= Enter the following data for the new model

Auni gue O6Named for the form model

Option: S 1 ect the O6Categoryd this form model wi || bel
categories that are defined on the [Categories] tab of the [Options] tab

(Maintain > Forms > Options ). Using categories makes it easier to loc ate

and manage multiple form models. Note: Categories are only available if license

component O6Advanced Forms6 is present

2 MyWeb - E-mail form models - Microsoft Internet Explorer E
Py
Maintain - E-mail form models 1
Form models in categary: | « All categories > vl
Form model
Select: | Contact form v‘ ‘ New form model H Copy form model |
Marme: ‘Contact farm Category: | < no category = v‘
Used in: MyWeb - Contact form
Steps
Steps: Selected step
Step name (title): |E-ma|\ farm Display: | WM Form L
Thank you,
Subtitle: | C55 class: |
Add part:

Text input field ” List ” Text ” Upload file

Text input field: Sender name

Text input field: Sender address

Preview Edit

[ T |
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2.2 Setting up the steps

Perform the following tasks to set up the steps for the e-mail form model. The following example
shows how to set up an e-mail form that contains six text input fields. For other  types of step
parts, see &@.3 Overview of step parts &

All e-mail formmodels cont ai n two pr edmeaiilnefdorsmd psn.dyddamank youdo
delete these steps or add additional steps, but you can rename them .

Selected step

Step name (title): |E—mai| farm Display: | WM Farm -

Subtitle: | CSS class: |

Add part:
Text input field || List || Text || Upload file

Text input field: Sender name == x|

Description: |Sender name

Default value: |

Required

Text input field: Sender address | == x|

Description: [Sender address

Default valus: |

Required

Preview Edit

The 6Thank youd step displays a page coermad address.g t ext t ha

| | |
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To add step parts, proceed as follows:

= On the [Steps] tab, click on the button of the desired part: 0
60Text 0, or 6Upl oad fil ed. I'n this Teneandplleextwe nwpiultl add
fieldd wildl a p theebattonromder neat h

Steps
Steps: Selected step
Contact information Step name (title): |CUntac:t information Display: | Wi Form A
Subtitle: | CSS olass: |
Add part:
Text input fie’\d List ” Text ” Upload file
Preview Edit
= |In the 6Descriptiond field, enter a dtethelefti pti on. Thi s

of the input field in the e-mail form.

= Enter the default value for this field. If you want the field to be empty in the form leave
this field blank.

= Indicate whether this field is required.

Text input field: [ ===

Descriptian: |Corn|:an5r narne

Default value: |

Required

<GX> CREATIVE ONLINE DEVELOPMENT B.V. e-mail info@gx.nl http://www.gx.nl/ 10/ 28
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= Click [More options  ].
= Select the type of 0Di s-@nly&oyndrah hpurform)x ampl e, a read
= Inthe 6 Def aul t sfiely yoa sah entet @SSto adjust the layout of the form part.

If, for example, a fields should be 100 pixels wide, width:100px  can be entered here.

This can be overruled for the individual fields.

= One by one, add additional parts to the step .

= To preview the form, click the [Preview ] tab at the bottom (see A in the image
below). For example:

2 MyWeb - E-mail form models - Microsoft Internet Explorer Elg
~

Maintain - E-mail form models

Form madels in category: | < All categories > ~|

Form model

Select: | Contact form || New form model || Copy form model
Hame: [Cantact farm Category: | < no category > -
Used in: MyWeb - Contact farm
Steps
Steps: Selected step
3 Step name (title): [Contact information Display: | wM Farm -
subtitle: | CsS class: |

Contact information

Company name *

Address

zip code

tity

Telephone number

E-mail address *

@ | rreview Edit L

= Fill the second step with a message for the visitor. The fields on this step are not
included in the e -mail.

<GX> CREATIVE ONLINE DEVELOPMENT B.V. e-mail info@gx.nl http://www.gx.nl/ ‘ 11/28 ‘
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2.3 Overview of step parts

Steps can contain parts of the following types :

e Textinputfield s
e Lists

e Text

e File uploads

2.3.1 St ep preaxtibputdield 6

Using this step part, you can create fields in an e-mail form into which website users can type
text. It can, for example, be used to enter personal data, passwords, notes, dates, numbe rs, e-
mail addresses, and so forth. You can define whether the field is required, the  width and height
of the field, embellish its look and feel with inline CSS styles and, if it is a password field, mask
the input in the web browser as the visitor is ente ring the text.

Text input field: E-mail address

= )
Description: |E-ma|\ address
Default value: |
Required
Presentation
Representation: | Wh Formpart v|W|dth: ,_ RaLE Cters,
Maximum length: ,7 TR Height: ,_ RS
[]rassward
Css class:|
Help text:l
Additional text: |
Advanced
Persunal\zatmn:l > Mo personalization =< -
%5l tag: |
¥alidation rules
> Select v

I T T T ]
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The fields of this part have the following meanings:

Field ‘ Description

Description

Label for the text input field.  This is the text that appears in
the e-mail form when it is displayed on the website. If the field
is required, an asterisk (*) appears to the right of the last letter
in the word .

Default value

Default text for this text input field. If left blank, there is no
default text. Default text can be modified by the website
visitor.

Required

Determines whether t his text input field is required. If it is
required, an asterisk (*) appears to the right of the last letter
in the word.

More Options

Presentation

Representation

Determines the look and feel of the field.
By default, these options are available:

e WM formpart (writable field)

¢ WM formpart date DDMMYYYY (date field)

¢ WM formpart hidden (invisible field)

¢ WM formpart readonly (read -only field)

e WM formpart Validation (input in the field will be validated
to ensure it is in the correct format, for example, if itis an
e-mail address, that it is of the form xxx@domain.com ).

Maximum length

Specifies the maximum number of characters allowed in this
text input field.

Width Specifies the width of the text input field (in characters).

Height Specifies the height of the text input field (in lines).

Password Specifies that this is a password field . When the visitor enters
their password, asterisks are displayed instead of characters in
order to mask the content .

CSS class Allows you to adjust the layout of the field using CSS

For example, if this text field should be 50 pixels wide, you
would enter width:50px

| |
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Help text

Specifies the text that should display if the visitor clicks a Help
icon. What exactly happens to this text is determined in the
website design.

Additional text

Allows you to display text behind the text input field. What
exactly happens to this text is determined in the design.

Advanced

Personalization

Determines which type of visitor this text will be visible to. If
there is no personalization, the text in the input field is visible
to all visitors.

XSL tag

The name of the tag for this text input field in the session. If
this field is left blank, the internal WebManager ID is used.

XSL tags are useful for personalization rules. XSL tags are also
used to position the fields in the design.

Validation rules

Validation

Validation rules for this text input field. These rules are

defined on the [Rules] tab of the [Options] tab nextto
type = 0V énhlyadadable through the Adva nced Forms
module).

By default, the following validation rules for text input fields
are defined (this list depends on modules you have purchased
for WebManager):

e Check date format

e  Check e-mail format

e  Check number format

e  Check date range

e Checkdecimal format

e  Check decimal range

e  Check number range

e  Check ZIP code format

e  Check telephone number format

<GX> CREATIVE ONLINE DEVELOPMENT B.V. e-mail info@gx.nl http://www.gx.nl/ 14/ 28
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This step part presents a list of selectable items. There are three variants : checkbox, radio
button, and pull-down menu. For check boxes and radio buttons, you can choose whether the
items are displayed horizontally ( side-by-side) or vertically ( from up to down ). The items can be

entered manually or you can use predefined lists. For example:

List: Country

Description: [Country
Itemns: () Predefined list
® Specify

Description

”Unlted States

”Canada

”United Kingdom

Default value: &) as specified above

Take value from form field

¥alue Checked Delete
[1 O
|2 O O
£ O O

List type: | Radio

* |Orientation: | vertical v

[ required
Presentation
Representation: | WK Farmpart e
Help text: |
Additional text: |
Advanced
Parsonahzatmn:l = Mo personalization < w
wSL tag: |
Yalidation rules
v

> Select

As defined above, the list wi Il appear as follows on the website:

Select your country of residence
Country @ United States

O Canada
O United Kingdom

<GX> CREATIVE ONLINE DEVELOPMENT B.V. e-mail info@gx.nl http://www.gx.nl/ ‘ 15/ 28 ‘
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The fields of this part have the following meanings:

Field ‘ Description

Description The list label. This is the text that will appear as the title for
the list on the website.

Items Indicates from where the items are derived: The items can be
either entered manually or derived from a predefined list .
Predefined lists are created on the [Predefined lists]

tab in the Maintain > Forms > Options dialog box. Note:
If this module has not been purchased, predefined lists are
not available.

Add items manually using the [Add item] button. Click [Add
item] h A field will [Additend r buttbno v €
Enter a name for the list item and assign a numerical value to

it. The numerical value assigned to the item is the identifier

for it in the session. Click Save (or Alt-S) after each item to
create subsequent list items. If you want one of the list items
to be selected by default, sel

Example:

Description: |Cuuntry

Items: () Predefined list

@ Specify
Description ¥alue Checked Delete
[United States ,1_ IF]
[canada O F]
|United Kingdom O Fl
Add item

Default value: () as specified above
Take value from form field

List type: | Radio | Orientation: | vertical w
[1 Required

¢« Less options

Default value Indicate the default items:

e As determined in the item definition
e Retrieve the value (s) from another form field in a
previous step from the pull-down list.

List type The format of the options list: Check box, radio button, or
pull-down menu.
Orientation For check boxes and radio buttons, select the orientation of

the list: horizontal (next to each other from left to rig ht) or
vertically ( from top to bottom ).

Required Determines whether at least one item must be selected.

I T T T ]
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More Options

Presentation

Representation

Determines the look and feel of the field.
By default, these options are available:

e WM formpart (writab le field)

¢ WM formpart date DDMMYYYY (date field)

e WM formpart hidden (invisible field)

¢ WM formpart readonly (read -only field)

¢ WM formpart Validation (input in the field will be validated
to ensure it is in the correct format, for example, if it is an
e-mail address, that it is of the form xxx@domain.com).

Help text

Specifies the text that should display if the visitor clicks a Help
icon. What exactly happens to this text is determined in the
website design.

Additional text

Used to display text behind the text list. What exactly happens
to this text is determined in the design.

Advanced

Personalization

Determines which type of visitor this text will be visible to. If
there is no personalization, the text in the input field is visible
to all visitors.

XSL tag

Name of the tag for this text input field in the session. If this
field is left blank, the ID is used.

The XSL tag is useful for personalization rules. The XSL tag is
also used to position the fields in the design.

Validation rules

Validation

Validation rules for this list. These rules are defined on the
[Rules] tabofthe [Options] t ab next to type

By default, no validation rules are defined for lists.

| |
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2.3.3 Step pextdt 6

The text step part is used to display text and/or image( s) on the e-mail form. For example:

Text: Thank you for your inquiry. We will contact you as soon as possible. = - x|

Description: |Thank vou for your inquiry. We will contact you as soon as possible.

Image: | Browsze. ..

Delete
Image alignment: | Right v|
Presentation
Representation: | WM Formmpart v|
Advanced
Personalization: | = No personalization < v|

On the website, the text part will appear as follows:
Thank you

Thank you for your inquiry.
We will contact you as soon as possible.

<GX> CREATIVE ONLINE DEVELOPMENT B.V. e-mail info@gx.nl http://www.gx.nl/ ‘ 18/ 28 ‘
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The fields of this part have the following meanings:

Field ‘ Description ‘

Description The text to be displayed on the form.

Image Select an image, if any, to display on the form.

Image alignment Controls the alignment of the image. The options are:
6Centeredd, 6 L eClletard , 6Right o, 0

More Options

Presentation

Representation Determines what the text should look like. By default, there
is only one option:

¢ WM formpart (default text field)

Advanced

Personalization Determines which type of visitor this text should be visible to.
If there is no personalization, this text is visible to all
visitors.

T T T
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2.3.4 St ep (Fierupl oalld

This part allows website visitors to upload a file to the website (for example, a passport picture
or a submitted article ). This is accomplished by entering a path and file name or navigating to the
file by clicking the [Browse] button.

Upload file: = - x|

Description: |At‘tachment

[] required

Presentation

Representation: | WM Formpart v|

Help text:l

Additional text: |(up to 2 MB)

Advanced
F‘ersonalization:| = Mo personalization < R
®5L tag: |
¥Yalidation rules
| = Select v

An example of how the file upload appears to the website visitor:

r Contact information

Company name *

Address

Telephone mber

Email address *

|
|
|
City |
|
|

Comment

Attachment |[ Browse |

[up o 2 MB]
Send

<GX> CREATIVE ONLINE DEVELOPMENT B.V. e-mail info@gx.nl http://www.gx.nl/ ‘ 20/ 28 ‘
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The fields of this part have the following meanings:

Field ‘ Description

Description The label that will appear beside the upload field in the
browser.

Required Determines whether a file must be selected or not.

More options

Presentation

Representation

Determines what the upload should look like.
By default, there is only one option:

e WM formpart (default layout)

Help text

Enter text that can be displayed when clicking a Help icon.
What exactly happens to this text is determined in the design.

Additional text

Enter text to display below the upload field (for example the
file types allowed, maximum size, etc.).

Advanced

Personalization

Determines which type o f visitor this upload option should be
visible to. If there is no personalization, this part is visible to
all types of visitors.

XSL tag

Name of the tag for this upload in the session. If this field is
left blank, the internal WebManager ID is used.

The XSL tag is useful for personalization rules. The XSL tag is
also used to position the fields in the design.

Validation rules

Validation

Validation rules for this upload. These rules are defined on
the [Rules] tab of the [Options] tab next to type =
6Ma dati oné.

By default, no validation rules are defined for uploads.

| |
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3 DEFINING AN E-MAIL FORM

You create e-mail form s for use on a page using an existing e-mail form model . Multiple e -mail
forms can be created using the same e-mail form model. This allow s you to use the same e-mail
form in multiple locations on the same website

To maintain existing forms or create new ones:
= Select menu Maintain > Forms > Email forms

= From the list of existing e-mail forms, select the form you want to see the details of (see
A'in the image below ).

When a new e-mail model is created, GX WebManager automatically also creates an e-mail form

instance with the same name as the model. The form instance can be renamedherei n t he 06 Name d
field (see B). If the form is already in use on one or more pages, the names are listed under
6PagedC).(see

23 MyWeb - E-mail forms - Microsoft Internet Explorer

Existing forms: selected form

” Mame: |Contact form ﬂ

Maodel: Contact farmm

Request form

Location: Step Page
E-rnail form o {not used on any page)
Thank you. {not used on any page)

— ENTERED DATA

— NEW FORM Period: from [z2/01/2008  [HD
Maodel: | < &ll categories = v to |30/01/2005 @
Contact form v Export to file:|
Name:| Export as:lCSU v|
| Export to directory | D
Files: Nome

T T T
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Creating more e-mail form instances from an e-mail form model has to be done manually.

= Select the model to use for this e -mail form from the pull -down menu (see A in the

image below).

= Type aname forthe newe-mai | f orm i n t(deeB) éndlcichg OK b o x

2 MyWeb - E-mail forms - Microsoft Internet Explorer

Existing forms:

Regquest form

Selected form

Name: [Cantact form
Model: Contact form
Location: Step Page
E-mail form
Thank you,

— ENTERED DATA

— NEW FORM

Period: from|2z/01/2008

Model: | < all categories >

E
to [3o/oneo0s [ER

| Contact farm

~|
- ‘ ﬂ Export to file:

Harne: [E-Mail form

Export as: | c5v v|

Files: Mone

The new e-mail form is now displayed in the list of existing forms
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4 PLACING A FORM ON A PAGE

4.1 Inserting a form content element

Once a form model has been created and has been used to create an e-mail form instance, th e
form can be placed on a page. To do this, perform the following steps:

= Place a form content element on a page using the Insert > User interaction >

For m menu.
= Seled the desiredform f r om t he 6 Shiow formd | i st
5 Form: E-Mail form ® 0dE ki
Show form: | E-Mail form w
Show steps: = Select

Contact form

Request form
E-rmail form

Thank wou.

Step: E-mail form

Rule: ¥erstuur e-mail

Send to: |
Messages:
Onderwerp (subject): mail van de website Replace
Inleidende tekst wan de mail: De volgende waardes zijn ingevuld: <sessionvalues = Replace

= If not all steps from this form should be shown on the same page, select 5 Speci fyd and
check only those steps to be placed on this page. The other steps can be placed on other
pages later:

5= Form: Contact form ®e HE B

Show form: | Contact form v

Show steps: (&) All steps on this page
O specify:
E-rnail form

Thank you.

Step: E-mail form

Rule: ¥Yerstuur e-mail

Send to: |
Messages:
onderwerp (subject): rail wan de website Replace
Inleidende tekst van de mail: De volgende waardes zijn ingevuld: <sessionvalues= Replace

Note: A step can be shown on only one page. It may not appear more than once.

T T T
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= Enter the e -mail address where the information that the website visitor enters should be
sent.

= Change the value of the Subject (if necessary) to alert the e-mail recipient of the nature
of the e -mail they will receive as a result of the e -mail form being filled out

=5 Form: Contact form [ -]

Show form: | Contact form w
Show steps: (%) all steps on this page
) Specify:
E-rnail form
Thank you,
Step: E-mail form

Rule: ¥Yerstuur e-mail

Send to: |test@gx.n|

Messages:
Onderwerp {subject): |Mail from the website, [JDelete
Inleidende tekst van de mail: De volgende waardes zijn ingevuld: <sessionvalues= Replace

= Click [ Save] or press <Alt-S>. The e-mail form is now ready to be used by website
visitors.
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4.2 Using entered form values in the e-mail

Using XSL it is possible to retrieve entered form values , for example, the vi si tor 6s name and
mail address. These values then can be incorporated in the e -mail.

In the follow ing example, an XSL tag is assignedto the entered text of a form step that qu eries
the name of the visitor. The name of the tég i s O6sender name

Text input field: Sender name H = R

Drescription: |Sender narme

Default value: |

Required

Presentation
Representation: | W Formpart A | Width: l_ EhanE Chohs
Maxirum length: ’7 AEEEErE Height: l_ FEE
[ rassward
€SS class: |
Help text: |
additional text: |
Advanced

Fersonalization: | = Mo personalization < ~
¥ SL tag: [sendername

= Select v

¥Yalidation rules
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In the Form content element of the e -mail, the entered value of this form field can be used. In
the following example: the entered value is included in the subject of the e -mail that is sent.

<xsl:value - of
select="//flow/formelement/formpart[@xsltag='sendername')/userentry" />

This value can be put into the Form content element, in the field with the e -mail subject:
2 Form: E-mail form .

Show form: | E-mail form b
Show steps: (&) All steps an this page
) Specify:
E-rnail form
Thank you,
Step: E-mail form

Rule: ¥Yerstuur e-mail

verzend naar: [test@gx.nl

Messages:

Cnderwerp (subject): |Ernail from website from sender: <xsl:value-of A [ Delete
select="/FlowHformelementformpart
[@xsltag="sendername']fuserentry" /= I b

Inleidende tekst van de mail: De volgende waardes zijn ingevuld: =sessionvalues> Replace
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